EarthLink Toolbar

The EarthLink Toolbar is a tool for accessing programs, files, and Web sites (Internet locations) quickly. When first installed, the
toolbar contains buttons to access EarthLink programs and your Internet tools. You can add additional buttons for any program,
file or Internet URL. This gives you quick and easy access to your computing tools. You can even include a folder that can
contain an additional collection of buttons. For example, you could add a folder for Games that contains buttons to all of your
game programs. (We’ve added a new folder to this toolbar.)
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Here’s what you can do with the toolbar:
Start the Toolbar
Set the Toolbar to Start with Windows
| the Toolbar
Add a Folder to the Toolbar
Add a Button for a File or Program
Add a Button for an Internet Location
Reorganize the Toolbar

For more information t EarthLink 5. EarthLink Help.
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A Starting the Toolbar

By default, the toolbar is set to start automatically with Windows. (The Startup with Windows option on the Toolbar menu is
checked.) If you have closed the toolbar, you can always start it again.
To start the toolbar:

P Click EarthLink Toolbar on the Start menu.

OR

P Select EarthLink Toolbar from the EarthLink Network folder in Programs.
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i&‘j Setting the Toolbar to Start with Windows
To set the toolbar to start with Windows:

P Right click on the toolbar and check Start with Windows on the menu.
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Closing the Toolbar

To close the toolbar:
I Right click on the toolbar and choose Close.

b Right click on the Toolbar icon in the System Tray or EarthLink on the Toolbar to display the menu.
F Select Close. You can always launch the Toolbar again from the Start menu.
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A Keeping your Toolbar Always on Top
To keep you toolbar on top:

I Right click on the toolbar and check Always On Top.
TIP: This is very useful if you dock your toolbar.
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i&‘j Turning Off "Always On Top"
If you don’t want your Toolbar to always be on top of your other programs, you can turn Always On Top off.

] Right Click EarthLink on the Toolbar to display the menu.
# Uncheck Always On Top.



A Making the Toolbar Dockable

To dock the toolbar:

P Right click on the toolbar and check Dockable.
TIP: If you plan to dock your toolbar turn on Always on Top so your toolbar doesn’t get lost beneath open windows.



# Docking the Toolbar
The toolbar can float on your screen or you can “attach” or “dock” it to the side of your screen. By docking your toolbar, you
keep it out of your way but still visible. Your toolbar must be set to “Dockable” before you can dock it.
To dock your toolbar:

# Make it Dockable

P Drag the toolbar to the desired side of the screen.

# Watch the toolbar attach itself.



L Dragging your Toolbar to a New Dock
To drag your toolbar to a new dock:
P Click and hold down the mouse button on the toolbar.
P Drag it to a different screen edge and release the mouse button.



# Using Drag and Drop
You can drag programs from your desktop or Windows Explorer tbo the Toolbar. A button for the program appears on the
Toolbar. Clicking on the button once it resides on the Toolbar launches the program.

You can also drag a button from one location on the Toolbar to another, this includes dragging a button from the main Toolbar to
a folder, or from a folder toolbar to the main Toolbar.



F Changing Toolbar Button Size
There are two button sizes available for the EarthLink toolbar, large buttons and small buttons. A toolbar with small buttons
takes up less room on your screen and allows you to show more buttons in a single row. A toolbar with large buttons takes up
more room on your screen but it’s easier to see the icons on the buttons.
To make the buttons (and the toolbar) smaller:

[ Right click on the toolbar and check Small Buttons.
To make the buttons (and the toolbar) larger:

P Right click on the toolbar and uncheck Small Buttons.



L Reorganizing your Toolbar
To reorganize the buttons on your toolbar:

P Click and hold the left mouse button down on the button you want to move then drag it to its new location.
# Release the mouse button.
You can also add folders to your toolbar and move buttons into the folders.



L Selecting a Toolbar Folder
When you’re adding a new button, you can choose where the button will ‘live’ — you can place your new button on the main
toolbar (by selecting Toolbar root from the Toolbar Folder field on the New Toolbar Button dialog), or you can place the new
button in another folder. If you haven’t created any folders for your Toolbar yet, you need to create a folder before you see it
listed under Toolbar Folder on the New Toolbar Button dialog.



F Adding a New Folder
You can add folders to your toolbar to group similar buttons. For example, add a folder for your favorite Internet locations or for
one of those games you like to play.
To add a new folder:

J Right click on the Toolbar to display the Toolbar menu.
# Choose New Folder... to open the New Folder window.
F Enter a name for the folder that identifies the type of programs or files you intend to keep in it.
P Optionally, click Change Icon... to choose a different image for your folder button.
I Click Ok. Your new folder button appears on the Toolbar.
Next time you add a button for a file or Internet location you can select this new folder from the list of Toolbar folders.



# Opening a Folder
To open a folder:

P Click on a folder to display its icons. Click on an icon to start the program or go to the URL.



# Deleting a Folder
To delete a folder:

b Right click on the folder icon you want to delete and click Remove.



F Changing the Icon for a Folder
To change the name or icon for a folder:
J Right click on the folder icon you want to change to display the menu.

P Click Properties to display the folder properties dialog.
The EarthLink Toolbar selects an icon for your button based on the file extension. For example, if you add a button for a PDF

file, the icon is a standard Acrobat PDF icon.

To change the icon:
P Click the Change icon... button on the New Shortcut dialog to display the
Select an icon dialog.

P Select an icon from those displayed, then click Ok.
If you don’t like your icon options, use Browse to locate a different icon. Many programs contain multiple icons that are included

as part of the program or you can choose an icon file.



F Adding a Button to a Folder
The quickest way to add a button to a Toolbar folder is to drag it to the folder button and drop it. Click on a folder to see the
button you just added.

To add a button to a folder:
] Drag a button from the toolbar to the folder.
OR

4 Right click on the folder icon, then choose Add button to display the New Shortcut dialog.

# Add a file or add an Internet Location (URL) then click Ok.
To add a button for a file:

[ Right click EarthLink on the Toolbar to display the Toolbar menu.

F Select New button... from the menu.

Pk Enter the Display Name for the file. This name will display when the cursor passes over the button on the toolbar.

# Enter the File Name or click Browse... to select the file from a directory. Toolbar selects an icon for the button based on the file

extension of the file you selected (.doc file will show the image of a page). You can change the icon.

# Select the Location for the button, either the Toolbar root or a folder you previously added to the Toolbar, then click Ok.
Note: The Toolbar supports drag and drop - you can drag your favorite program or file to the Toolbar (or to a folder in the
Toolbar) and Toolbar adds a button for it.



L Dragging a Button to a Folder
To drag a button to a folder:

P Click and hold down the left mouse button on the button you want to move then drag the mouse until the cursor is over the folder.
F Release the mouse button.



F Changing the Icon for a Button
To change the icon for a button:
] Right click on the button to popup the menu.
P Select Properties.
P Click Change Icon... to display the Select an icon dialog. This dialog shows the name of the file the buttons come from.
4 Highlight a different icon and click Ok to select it or click Browse... to look for a button elsewhere.
P Click Ok to close the properties dialog



L Adding a Button for a Web Page URL
To add a button for a Web site:
] Right click on the toolbar to popup the menu.
P Select New button... to display the New Toolbar Button dialog. This dialog enables you to add a button for a file or an Internet
Location (URL).
P Click the Internet Location (URL) tab.
F Enter the name that you want to appear when the cursor moves over the button.
# Enter the URL or click Import... to select a URL from your list of Favorites. If you have more than one browser on your system,
there will be a tab listing the favorites/bookmarks from each browser. Click the desired tab and select the desired URL, then click
Ok.
F Select the folder you want to put the new button in. If you have not created any folders for your toolbar, the only option will be

Toolbar root.
b Optionally, click Change Icon... to select a different icon for the file.

P Click Ok to save the new button and add it to the toolbar.



L Adding a Button for a Program or File
To add a button for a program or file:
] Right click on the toolbar to popup the menu.
P Select New button... to display the New Toolbar Button dialog. This dialog enables you to add a button for a file or an Internet
Location (URL).
# Enter the name that you want to appear when the cursor moves over the button.
F Enter the file name or click Browse... to select the file from your hard drive.
F Select the folder you want to put the new button in. If you have not created any folders for your toolbar, the only option will be
Toolbar root.
P Optionally, click Change Icon... to select a different icon for the file.
P Click Ok to save the new button and add it to the toolbar.



L Removing a Button from the Toolbar
To remove a button from the toolbar:

b Right click on the button you want to remove then choose Remove.



# Moving a Toolbar Button
To move a Toolbar button, drag it to a new spot on the Toolbar.



Pk Selecting Toolbar Options
There are a collection of options for the Toolbar.
J Right click EarthLink on the Toolbar to display the Toolbar menu.
P Right click on a button to display its options (Open, Remove, and Properties).
P Right click on a folder to display its options (Open, Add Button, Remove, and Properties).



# Adding a Button to the Toolbar
You can add a button for a file or program, or an Internet Location.

Note: The Toolbar supports drag and drop - you can drag your favorite program or file from the desktop or Windows Explorer to
the Toolbar (or to a folder in the Toolbar) and Toolbar adds a button for it.



F Adding a Button for an Internet Location (URL)

To add a button for an Internet Location (URL):
J Right click EarthLink on the Toolbar to display the Toolbar menu.
F Select New button... from the menu.

P Click on the Internet Location (URL) tab.
# Enter the Internet Location (URL) or click Import... to select an Internet location from your list of Favorites.

Toolbar displays the default icon for the file type. You can change the icon if you don’t like it.

b Change the Display Name for the file, if necessary. This is the name that displays when the cursor passes over the button.
P If you have added a Folder to your Toolbar, select the Location for the new button from the drop down list. This list box shows

the Toolbar root (the main toolbar) and the names of any folders you have added. This option is not available if there are no folders

on your Toolbar.

P Click OK.
Note: The Toolbar supports drag and drop - you can drag your favorite program or file to the Toolbar from the desktop or from

Explorer (or to a folder in the Toolbar). The Toolbar adds a button for it.



# Browsing for Different Icons
If you don’t like your icon options, use Browse to locate a different icon.
P Click Browse on the Select an Icon dialog.
P By default, the Open dialog is set to look for Icon files. If you’ve downloaded icons from download.com or filepile.com, then you
should look for icon files. However, if you want to look at the icons other programs developers have included with their programs,
select Files of type Executable files.
F Select the folder you want to look in, then click Open. The icons appear on the Select an Icon dialog.
P Select the desired icon, then click Ok to return to the New Shortcut window.



F Changing the Display Name for a Button
The Display Name for a button is the text that appears when the cursor moves over the button. If you don’t like the text
description, you can change it.

b Right click the button you want to change text for.

F Select Properties.

F Delete the Display Name as it appears.

F Type a new Display Name.

P Click Ok.



F Using the System Tray
The System Tray is part of the Windows Taskbar and usually appears in the lower right corner of your screen. (The clock lives
in the System Tray.) Many programs that run when you start Windows place an icon in the System Tray to show that they are
running on your system. (When you’re connected to the Internet, there is a little connection icon in the System Tray.)

# Drag your mouse over an icon to display a description of the icon.

b Right click on an icon to display the menu for that icon.

# Double-click on an icon to open the program.



# Using the Windows Taskbar
The Windows Taskbar usually resides at the bottom of your screen. The Taskbar consists of the Start button, buttons for each
of the programs you have open and the System Tray.
Like everything else in the Windows world, the Taskbar has properties associated with it — properties you can set to suit you.

J Right click on the Taskbar to display its menu.

P Select Properties from the menu to reset Taskbar properties.

# Check the properties you want to use:
. . Always on Top

. . Show small icons in Start Menu
. . Show clock



# EarthLink Toolbar Keyboard Shortcuts
With the EarthLink Toolbar menu open:

Close

Dockable (On/Off Toggle)

New folder

New button

Always on Top (On/Off Toggle)
Startup with Windows (On/Off Toggle)
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Always on Top keeps the Toolbar on top of all windows, not allowing it to be hidden by another window.
This is very helpful if you use your toolbar a lot and don’t want it to be hidden by another program.



Move to Tray - Moves the Toolbar to the System Tray (the area in the Taskbar where the time “lives”). Click the icon in
the tray to restore the Toolbar back to its last position.



Dockable - Allows the Toolbar to attach itself to the edge of the screen when you drag it there. You can drag it from one
side of the screen to the other and it will reattach.



Small Buttons - Toggle between large and small buttons on the Toolbar.



Startup With Windows - Check this option to start the EarthLink Toolbar each time you start Windows.



New folder... - Displays the Add folder dialog so you can add a folder to the Toolbar. Folders allow you to group a
collection of icons, useful if you have a lot of programs you want to be able to access from the Toolbar. Folders on your
Toolbar have a little folder in the upper right corner.



New button ... - Displays the New Shortcut dialog so you can add a button for a file (program or document) or an
Internet location to the Toolbar (or to a Toolbar folder).



Close - Quit the EarthLink Toolbar.



About EarthLink Toolbar - Shows version information for the EarthLink Toolbar.



Help - Displays the Help menu: About EarthLink Toolbar, Table of Contents



Table of Contents - Display the Table of Contents for the Toolbar Help file.



Selecting an Internet Location - When you click Import... on the New Shortcut — Internet Location (URL) tab the Select
Internet location dialog appears. This dialog lists the bookmarks stored in your browser. If you have Netscape
Navigator and Internet Explorer your computer, there will be a tab for each. Select the tab for the browser from which
you want to select a bookmarked URL. Highlight the desired bookmark then click OK.



Reviewing Properties for a Toolbar Button - The Properties of a button are its name, the file name it references, its
location on the toolbar, and the icon that displays on the toolbar. To change the properties of a toolbar button: Right
Click on the desired Toolbar button. Select Properties from the menu. Make the desired changes, then click OK.



Tip of the Day - Display the Tip of the Day dialog.



Display Name - Enter a name for your program, document, or Internet location as you want it to appear when your
cursor floats over the button.



File Name - Enter the name of the file, or click Browse to locate the file.



Browse - Click this button to locate a file.



Change Icon - Click this button to change the icon for the file or location.



Internet Location (URL) — Shows the URL (Universal Resource Locator) oraddress for the selected bookmark/favorite in
the format http://www.earthlink.net



Location - The location list box lists the Toolbar root and any folders you have added to the Toolbar. Select the desired
location for the new shortcut.



Current icon - Shows the list of icons available in the directory where File name is located. The current icon is
highlighted. Select a different icon by highlighting it then clicking OK.



New Shortcut - File - Use this dialog to add a new button for a file to the Toolbar.



New Shortcut - Internet Location (URL) - Use this dialog to add a new button for an Internet Location to the Toolbar.



Bookmarks/Favorites - lists the bookmarks for Netscape or the favorites for EarthLink or Internet Explorer.



Restore
Click the Toolbar Icon in the System Tray.



Dockable
A dockable toolbar sticks to a screen edge when you drag it near the edge.

P Right Click EarthLink on the Toolbar to display the menu.
# Check Dockable.



Change Size
Toolbar buttons can be large or small. Small buttons enable you to fit more buttons on the toolbar and the toolbar takes up less
space on your desktop.

F Right Click EarthLink on the Toolbar to display the menu.
# Check Small Buttons to make the buttons small. (Uncheck to make them large again.)



Rename
You can relabel the text that appears beneath a button when your cursor floats over it.

P Right click the Button you want to rename
F Click Rename.
# Change the label text.



On Top
You can keep your Toolbar on top of all your other programs. (By default, this option is checked.)
P Right Click EarthLink on the Toolbar to display the menu.

# Check Always On Top.
The Toolbar will stay on top of all windows. This makes the Toolbar always visible, no matter how many programs you open.

If you plan to “dock” the Toolbar, you should have Always On Top checked so you can see the Toolbar once you unhide it.
Otherwise, it reappears beneath your current window.



Properties

The Properties dialog shows the name that appears when you float your cursor over a toolbar button, the icon that appears in the
button, the program, URL or email address associated with the button and the toolbar folder it resides in. Use this dialog to
modify the name that displays when you cursor floats over a button, to change the file name referenced by the button, or to
change the icon that appears on the button. You cannot change the location of the button on the Toolbar from the Properties
dialog (you simply drag the button from one Toolbar location to another).



Remove
There may come a time when you need to remove an icon from the EarthLink Toolbar.

P Right click on the icon that you wish to remove.
F Select Remove.



New Label — Enter a new label for this button.



Enter the Filename or click Browse to look for the file on your computer.



P Add Button
EarthLink 5.0 installs buttons for EarthLink programs, such as Dialer, Registration and Utilities and Support Wizard as well as
Internet programs, such as Netscape Navigator or Microsoft Internet Explorer. You can add buttons to the Toolbar for any

program on your computer, any file on your computer, or any Web page.

You can add a button for a file or program, or an Internet Location.
Note: The Toolbar supports drag and drop - you can drag your favorite program or file from the desktop or Windows Explorer to
the Toolbar (or to a folder in the Toolbar) and Toolbar adds a button for it.

» Right click on a button, then choose Remove to remove it from the Toolbar.



# Menu
Right click EarthLink on your toolbar to show the following menu:

Click on an option to see its description.

Use this menu to change the various settings of the Toolbar and make it look the way you want it to. The Toolbar is able to attach
itself to the sides of your screen (dock) and even hide itself when not in use.



¥ New Toolbar Button
Use this dialog to add a button for a file or an Internet location (URL).

P Click the desired tab: File Internet Location (URL).



P File
Use this tab to find a file and attach it to a button on your EarthLink Toolbar.

P Click Browse to look for a file on your computer. The Open dialog appears so you can navigate to the directory/folder that

contains the file.
P If you want the new button to be on the main Toolbar (instead of in a Toolbar folder), and you like the icon, click OK.  You can

select a different icon, or place the button in a different Toolbar folder.



P Internet Location (URL)
Use this tab to import an Internet location from a browser program and attach it to a button on your EarthLink Toolbar.

P Click Import to select a bookmark or favorite from your browser program.

P If you want the new button to be on the main Toolbar (instead of in a Toolbar folder), and you like the icon, click OK.  You can
select a different icon, or place the button in a different Toolbar folder.



# New Internet Button
Each tab on this dialog lists bookmarks/favorites for a browser program. If you have more than one browser installed on your
computer, you will see a tab for each.

b Highlight the Internet location you want to create a button for.
The URL for that bookmark/favorite appears in the Internet Location (URL) field.
P Click OK to select it.



F Select an icon
This dialog enables you to select a different icon for your button.

The File Name shows the executable or .dll file that contains the icons you see in the Current icon area. Click Browse to find a
different .exe or .dll file that contains icons.

The Current icon area shows the icons available in the current file. Highlight the desired icon then click OK.



F Closing Connection Manager
Connection Manager monitors your connection (or lack thereof) to ensure that you’re connected when trying to view a website or
collect email. If you’re not connected, Connection Manager pops up a prompt to ask if you would like to connect to the Internet.
If you think Connection Manager is interfering with other programs on your system, you can close it.
To close Connection Manager:
Press CTRL+ALT+DEL to display the Close Program dialog.

Select Conmgr then click End Task.



# New Toolbar Button
Use this dialog to add a new button to the toolbar.

# Do one of the following:
Adding a Button for a Web Page URL
Adding a Button for a Program
I Click OK to save your changes or click Cancel to ignore any changes.



# Rename
Enter the new name for the button or folder.



Select an Icon —
This dialog shows the name of the file that contains the icons available to you. By default, this is the program file for the
EarthLink Toolbar, toolbar.exe. It contains the five icons shown.

# Select an icon from those displayed, then click Ok.
P If you don’t like your icon options, use Browse to locate a different icon.
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You are low on system resources

Your system may not behave as expected while in this condition. To remedy the low on resources condition, close any
extraneous EarthLink 5.0 windows or other programs that are currently running on your computer that you are not currently
using. To close EarthLink 5.0 windows you are no longer using, click on the Window menu and select the name of the window
you want to close, then either double-click on the icon to the left of the File menu, or select Close from the File menu. Repeat
this process until you have closed all extraneous windows.

Note: If you have a number of icons in your System Tray, these also impact system resources. If you consistently get “low on
resources” messages, you should consider closing a number of these programs. To close a program in your System Tray, right
click on the icon and click Close or Exit.



You are no longer connected to the Internet

You will not be able to send or receive email, upload or download files, or view web sites online unless you are connected to the
Internet. Click Yes to connect to the Internet now. Click No to continue working offline.



EarthLink Technical Support

EarthLink maintains a website containing solutions to many technical issues at http://help.earthlink.net
EarthLink Technical Support is available 24 hours a day, 7 days per week at (800) 890-5128.
MindSpring customers can get Technical Support for their accounts 24/7 at (800) 719-4660.






